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Microsoft, Excel, and Windows are trademarks or registered trademarks of Microsoft Corporation. 
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1. Software Overview 

This software, “Windows Communication Tools for Counting Scale” (hereinafter called “WinCT-Counting”), is a 
setting tool that assists the use of counting scales manufactured by A&D as follows. 
 
□ Edits on a PC the “UFC output format" output by the counting scale and saves it to the counting scale. 
□ Checks the function settings of the counting scale with a PC, and saves changes to the counting scale. 
□ Transmits commands to the counting scale. 
□ Checks internal memory of the counting scale with a PC. Saves a list to the PC, and then saves it to the counting scale. 
 
“WinCT-Counting” can be downloaded from the A&D website ( https://www.aandd.jp/ ). 
To setup “WinCT-Counting”, please refer to the WinCT-Counting_SetUp_EN file in the downloaded A&D 
WinCT-Counting folder. 
 
  

https://www.aandd.jp/
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1.1. How to Connect 

1. Connecting the counting scale to a PC 

(1) If the PC is equipped with an RS-232C interface 
 Check the RS-232C interface pin arrangement of the counting scale and PC. Ready an RS-232C cable and connect them. 

 
 
 
 
 
 
 
 
 Counting scale PC 
 
 

(2) If the PC is not equipped with an RS-232C interface, or if you prefer to use a USB interface 
Required item: AX-USB-9P USB converter cable set 
(Driver needs to be installed. Refer to the instruction manual of the USB converter.) 

 
 
 
 
 
 
 
 
 Counting scale PC 
 
 
 

(3) When the GC series counting scale is routed through the AD-8561-MI02, ready a USB micro B - to - A 
cable and connect the USB interface of the AD-8561-MI02 and the one for the PC. 
(A USB driver for the AD-8561 is required. Refer to the instruction manual of the AD-8561.) 
However, the AD-8561 is not usable with the UFC function (barcode label).  

 
 
 
 
 
 
 
 
 GC series counting scale AD-8561 PC 
 

Note 
When the RS-232C interface of the AD-8561 is used, the procedure is same as that of (1) and (2) above. 
However, in that case, set the baud rate of the RS-232C port for the AD-8561 to 9600 bps or more. 
(For the settings, refer to the instruction manual of the AD-8561.) 

 
2. Check the COM port name and COM port number with the Device Manager, etc.  

RS-232C cable 

D-Sub  D-Sub 
(9 pin)  (9 pin) 

AX-USB-9P USB converter cable set 

D-Sub 
(9 pin) 

USB 
Type A 

USB 
micro B – A cable 

USB USB 
micro B Type A 

RS-232C cable 

D-Sub D-Sub 
(9 pin) (9 pin) 
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1.2. Sections of the software (common to all modes) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Menus 
File menus 
Operates files. 

Name Description 
Open  Reads files. 

Send Data Reads transmitted data. 
Barcode Data Reads data created in the UFC-barcode mode. 

New  Clears data 
 Send Data Clears transmitted data. 
 Received Data Clears received data. 
Save  Saves data in files. 

Send Data Saves data in the Send Data box. 
Received Data Saves data in the Received Data box. 
Barcode Data Saves data created in the UFC-barcode mode. 

Print  Outputs to a printer. 
 Send Data Outputs transmitted data. 
 Received Data Outputs received data. 
End  Exits WinCT-Counting. 

  

(1) Menus 

(3) Mode switching tabs 

(4) Operation Guide 

(7) Send Data/Received Data boxes 
 

(2)  

(5) Connect/Send button (6) Clear Received Data/Disconnect button 
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RS232C menu 
The RS-232C communication settings 

Name Description 
Com Port Sets the COM port. Displays the list of available ports. 
Baud Rate Sets the baud rate. 

600 / 1200 / *2400 / 4800 / 9600 / 14400 / 19200 / 28800 / 38400 bps 
Parity Sets the parity. 

*Even (E) / Odd (O) / None (N) 
Length Sets the data length. 

*7 / 8 bits 
Stop Bit Sets the stop bit. 

*1 / 1.5 / 2 bits 
Terminator Sets the terminator. 

*CR/LF / CR 
* Default setting 
 
 
Wait[s] menu 
A transmission interval is inserted between lines. Specify it according to the intended counting scale or 
conditions as it varies depending on the receive buffer size or the data processing time of the counting scale. 
Name Description 
 A transmission interval inserted between lines [second(s)]. 

0.0 / 0.1 / 0.2 / 0.3 / 0.4 / 0.5 / 0.6 / 0.7 / 0.8 / 0.9 / 1.0 / 
1.1 / 1.2 / 1.3 / 1.4 / 1.5 / 1.6 / 1.7 / 1.8 / 1.9 / 2.0 

 
 
Model menu 
Specifies the counting scale (displays the list of compatible models).  

Name Description 
 Specifies the counting scale. 

 
 
Option menu 
Optional setting 

Name Description 
Language Selects the preferred language. 

Japanese / *English 
* Default setting 

 
 
(2) Model 

The currently selected model is displayed. 
To change the model, use the Model menu. 
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(3) Mode switching tabs 

Name Description 
UFC-Dump UFC function 

Creates UFC commands in the UFC-dump mode and stores UFC format on 
the counting scale. This mode is for printing data transmitted from the 
counting scale as it is. 

UFC-Barcode UFC function 
Creates UFC commands in the UFC-barcode mode and stores UFC format 
on the counting scale. This mode is for printing data transmitted from the 
counting scale on a barcode label. 

Function Function settings 
Confirms or changes the current function settings of the counting scale. 

Command Commands 
Selects commands that are valid on the counting scale and transmits  
to the counting scale. 

Memory Memory function 
□ Reads internal memory of the counting scale, and builds lists, and save 
 them in a csv file. 
□ Reads memory data from a file and saves it to the counting scale. 
□ Creates and saves memory data of the SD card for external memory. 

 
 
(4) Operation Guide 
 

Displays the simplified operating procedures for each function. 
 
 
(5) Connect/Send buttons 

Name Description 
Connect button Starts communication with the counting scale. 

(When communication starts, Connect changes to Send.) 
Send button Transmits the character strings in the Send Data box to the counting scale. 

(When the Disconnect button is pressed, Send changes to Connect.) 
 
 
(6) Clear Received Data/Disconnect buttons 

Name Description 
Disconnect button Ends communication with the counting scale. 

(When communication ends, Disconnect changes to Clear Received Data.) 
Clear Received Data button Clears the Received Data box. 

(When the Connect button is pressed, Clear Received Data changes to 
Disconnect.) 
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(7) Send Data & Received Data boxes 

Name Description 
Send Data box Displays commands to transmit to the counting scale. The user can type 

text in here directly. 
When a blank line (a line with a terminator only) is inserted, the blank line 
and following lines will not be transmitted. Remarks, output results, etc. 
put there will be useful for future reference. 

Received Data box Displays the character strings received from the counting scale. The user 
can type text in here directly. 
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1.3. Operation (common to all modes) 

1. Starting the WinCT-Counting software 
 

To begin, click the Start button on the PC. 
Then, navigate to All Programs > A&D WinCT-Counting > WinCT-Counting or search for  
WinCT-Counting application to start WinCT-Counting. 

 
2. Selecting a model 
 

Click the Model menu and select the model of the counting scale to connect. 
 
 
 
 
 
 
 
 
 
 
 
 
3. Configuring the communication settings 

 
Click the RS232C menu and select from COM Port the COM port for communicating to communicate 
with the counting scale. Make sure that the settings of RS-232C match the communication settings 
of the counting scale. 
(The initial values of WinCT-Counting’s communication settings are the same as the factory settings 
of the A&D counting scale.) 
The COM port number can be confirmed with the Device Manager. 

 
Note 
 When the AD-8561 is used with a GC series counting scale, set the communication settings of the  
 counting scale to AD-8561-MI mode, and then make the communication settings of WinCT- 

 Counting match those of the AD-8561. 
 (For the communication settings of the AD-8561, refer to the instruction manual of the AD-8561.) 
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4. Setting a counting scale 
 

When using the UFC function, make sure that the counting scale is set to UFC mode. For the method of  
setting, refer to the instruction manual of the counting scale. The settings can be confirmed/changed by the  
function setting. 

 
 
5. Click the Connect button to connect to the counting scale. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. When transmitting the contents of a file saved on a PC directly to the counting scale 

 
Click Open in the File menu, and then select Send Data to select and open the file created. 
You can create commands in a txt file or a csv file and batch send to the counting scale. 
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7. When saving text in Send Data or Received Data 
 

Click Save in the File menu and select Send Data or Received Data, and then save as a new file. 
You can save the text in txt or csv format. 

 
 
 
 
 
 
 
 
 
 
 
 
 

8. Closing the WinCT-Counting window 
 

 Click End in the File menu or the “X” (close) button on the upper right corner of the window. 
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2. UFC-Dump Mode 
 
 

2.1. Abilities of the UFC-dump mode 

□ A&D counting scales equipped with the UFC function can output weighing data in customized formats (UFC  
 Output Format*1). 
 Thus, the user can change the form of output data, the order to print, etc. when printing with a printer capable  
 of dump printing. 
 With the AD-8127, set the printer to dump print mode. 
 (For the settings, refer to the instruction manual of the printer.) 
 
 
 
 
 
 
 
 
 
□ With UFC Output Format, the following three can be output: Static text, variable data that a counting scale holds 

(such as weighing data) and the control code in ASCII. Each of them can be combined with the others to be 
output together. For details, refer to the instruction manual of the counting scale. 

 
 

2.2. How to use the UFC-dump mode 

□ To output data in UFC Output Format from a counting scale with the UFC function, the UFC Output Format 
settings must be already stored in the counting scale. 

 
□ To store the UFC Output Format settings to the counting scale, it is necessary to transmit commands in a specific 

format (UFC Setting Commands*2) from a PC to the counting scale. 
 
□ The UFC Mode of WinCT-Counting is an application designed for editing UFC Output Format on a PC as well 

as for transmitting UFC Setting Commands to the counting scale. 
 
 

Edits or sets UFC Output Format Outputs or prints in the format that has been set 
 
 
 
 
 
 

Counting scale PC Counting scale Printer 
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*1 UFC Output Format may be referred to as "UFC format", "output format" or "format" in the instruction manual  
 of the counting scale used. 
*2 A UFC Setting Command may be referred to as a “PF command”, “UFC command” or “UFC program command”  
 in the instruction manual of the counting scale used. 
 
 
Note 
□ UFC Setting Commands transmitted to the counting scale are saved even when the power is turned off. 
□ The number of characters that can be stored, UFC Setting Command format, and the cable/options required for 

connection to a PC will vary depending on the counting scale. For details, please refer to the instruction manual 
of the counting scale used. 

 
 

2.3. Features of the UFC-dump mode 

□ UFC Output Format can be easily created by selecting data to be printed, such as weighing values, unit weight, 
etc. and also by entering text to be printed. 

 
□ Editing and adjusting formats can be done effortlessly on a PC screen thanks to the Preview Screen, which 

displays the UFC Output Format to be output from the counting scale. 
 
□ UFC Setting Commands can be automatically generated from the edited format and can be transmitted to and 

stored on the counting scale. Data received from the counting scale can be displayed on the PC screen. 
 
□ The contents of the edited UFC Output Format, UFC Setting Commands, and data received from the counting 

scale can be saved as and imported to a csv file. Printing to a printer from the PC is also possible. 
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2.4. Sections of the UFC-dump mode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(1) Tools for editing 

Output data can be edited with these tools. 

Name Description 
Command List menu Displays the list of available variable data. 
Add Command button Adds the variable data selected in Command List to Editing Screen. 
Text Box Text entered here is added to Editing Screen by pressing the Enter key. 

(A blank space can be also added.) 
Add Text button Adds the text displayed in Text Box to Editing Screen. 
Row Up button ( ) Moves the row selected in Editing Screen (highlighted in blue) up one row. 
Row Down button (  ) Moves the row selected in Editing Screen (highlighted in blue) down one row. 
Clear Editing Screen button Clears the data listed in Editing Screen. 

 
 

(2) Editing Screen 
The UFC Output Format can be edited on this screen. 

Name Description 
Text column Lists the variable data and text added by the user. 

Text can be edited on this screen. Variable data is displayed with a gray 
background and cannot be edited. 

CRLF column If the check box next to an item has a checkmark in it, a line break code is  
added at the end of the line. If it does not have a checkmark, no line break  
code is added, so the line is connected with the next line. 

Button column Clicking the Delete button in a row deletes that row. 
 
 
(3) Preview Screen 

A print preview is displayed on this screen. 
Displays in the UFC Output Format data edited in Editing Screen. In this preview, the part corresponding to 
variable data is replaced by a sample form of data for the purpose of showing an example of the counting scale’s 
output. This example has the same number of characters as actual data, although its content is not the same.  

(3) Preview Screen (2) Editing Screen (1) Tools for editing 
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2.5. How to operate the UFC-dump mode 

Perform steps 1 to 4 in “1.3. Operation (common to both modes)”.  
Select the UFC Mode tab to open the UFC function screen. 
 
5. Creating UFC Output Format 

 
6. Sending UFC Setting Commands from the PC to the counting scale 
 

(1) Click the Connect button, which will then change to the Send button when communication starts. 
(2) When you click the Send button, the commands displayed in the Send Data box will be sent line by 

line to the counting scale. Between the lines, the time set in Wait[s] will be inserted. 
(3) Transmitted UFC Setting Commands are stored in the counting scale. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7. Receiving data from the counting scale 

 
 □ To output data, press the print key on the counting scale. 
 □ The data output is displayed in the Received Data box, so check that the contents of the data are  
  correct. 
 

8.  Ending communication 
 

 Click the Disconnect button.  

Step 5. Creating UFC Output Format 

Step 6. Sends UFC Setting Commands by clicking the Connect button which will change to the Send button 

Displays a reply to the commands sent 

Displays commands to send 
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3. UFC-Barcode Mode 
 
 

3.1. Abilities of the UFC-barcode mode 

□ A&D counting scales equipped with the UFC function can output weighing data directly from the counting scale 
to print on barcode labels or two-dimensional code labels without PC, by editing the UFC Output Format*1 in 
such a way as to output a control character with a label printer. 

 
 
 
 
 
 
 
 
 
□ With UFC Output Format, the following three can be output: Static text, variable data that a counting scale holds 

(such as weighing data) and the control code in ASCII. Each of them can be combined with the others to be 
output together. For details, refer to the instruction manual of the counting scale. 

 
 

3.2. How to use the UFC-barcode mode 

□ To output data in UFC Output Format from a counting scale with the UFC function, the UFC Output Format 
settings must be already stored in the counting scale. 

 
□ To store the UFC Output Format settings to the counting scale, it is necessary to transmit commands in a specific 

format (UFC Setting Commands*2) from a PC to the counting scale. 
 
□ The UFC Mode of WinCT-Counting is an application designed for editing UFC Output Format on a PC as well 

as for transmitting UFC Setting Commands to the counting scale. 
 

Edits or sets UFC Output Format Outputs or prints in the format that has been set 
 
 
 
 
 
 

Counting scale PC Counting scale Label printer 
 
The AD-8561 is not usable with the UFC-barcode mode. 
 
*1 UFC Output Format may be referred to as "UFC format", "output format" or "format" in the instruction manual  
 of the counting scale used. 
*2 A UFC Setting Command may be referred to as a “PF command”, “UFC command” or “UFC program command”  
 in the instruction manual of the counting scale used. 

SAMPLE  ABC-123 SAMPLE  ABC-123 

Label printer 
(Compatible with ZPL®/ZPL ®) 
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Note 
□ UFC Setting Commands transmitted to the counting scale are saved even when the power is turned off. 
□ The number of characters that can be stored, UFC Setting Command format, and the cable/options required for 

connection to a PC will vary depending on the counting scale. For details, please refer to the instruction manual 
of the counting scale used. 

 
 

3.3. Features of the UFC-barcode mode 

□ UFC Output Format can be easily created by selecting data to be printed, such as weighing values, unit weight, 
etc. and also by entering text to be printed. 

 
□ Editing and adjusting formats can be done effortlessly on a PC screen thanks to the Preview Screen, which 

displays the UFC Output Format to be output from the counting scale. 
 
□ UFC Setting Commands can be automatically generated from the edited format and can be transmitted to and 

stored on the counting scale. Data received from the counting scale can be displayed on the PC screen. The 
program for printing barcode labels can be edited with a label printer (which programming language is 
compatible with ZPL® and ZPL 

®
 ). 

 
□ The contents of the edited UFC Output Format, UFC Setting Commands, and data received from the counting 

scale can be saved as and imported to a csv file. Printing to a printer from the PC is also possible. The printable 
types of barcodes and two-dimensional codes with the UFC-barcode mode are QR codes, DataMatrix codes, 
and Code 39. 

 
 
 
 
 
 
 

Print example of a QR code Print example of a DataMatrix code Print example of a Code 39 

SAMPLE  ABC-123 SAMPLE  ABC-123 SAMPLE  ABC-123 
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3.4. Sections of the UFC-barcode mode 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Barcode Type/Print Settings/Text Data 
Barcode types and print settings can be selected, and printing text can be edited with these tools. 

Name Description 
QR Code Prints QR code and text. 
Data Matrix Prints DataMatrix code and text. 
Code 39 Prints Code 39 and text. 
Res menu Selects the print head resolution of a label printer. 

203 dpi [8 dot/mm]/300 dpi [12 dot/mm]/406 dpi [16 dot/mm]/600 dpi [24 dot/mm] 
Height menu Enters the label length. The unit is mm. (10 to 100 mm) 
Width menu Enters the label width. The unit is mm. (10 to 100 mm) 
# of Prints menu Enters the number of sheets to print at a time. (1 to 10 sheets) 
Type menu Selects the variable data and text. 

Text/Command 
Text box Select [Text] from [Type], and it turns the entry field for letters. 

Select [Command] from [Type], and it enables selection of the variable 
commands. The type of command differs depending on models. 

Size menu Sets the text size. The unit is dot. 
  

(1) Barcode Type/Print Settings/Text Data (6) Design Preview 

(2) Barcode Data (3) Editing Screen (5) Data Preview 

(7) Create UFC Commands 

(4) Size 
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(2) Barcode Data 
The barcode data can be edited with these tools. 

Name Description 
Command List menu Displays the list of available variable data. 
Add Command button Adds the variable data selected in Command List to Editing Screen. 
Text box Text entered here is added to Editing Screen by pressing the Enter key. 

(A blank space can be also added.) 
Add Text button Adds the text displayed in Text Box to Editing Screen. 
Row Up button (  ) Moves the row selected in Editing Screen (highlighted in blue) up one row. 
Row Down button (  ) Moves the row selected in Editing Screen (highlighted in blue) down one row. 

 
 

(3) Size 

Name Description 
Height menu Sets the barcode height. (DataMatrix code and Code 39 only) 
Width menu Sets the barcode width. (Code 39 only) 
Magnification menu Sets the barcode magnification. (QR code only) 

 
 

(4) Editing Screen 
The barcode data can be edited with these tools. 

Add data here to put data in a barcode. 
For a two-dimensional barcode, each data is put on a new line. 
For a one-dimensional barcode, all data is put on one line. 

Name Description 
Text column Lists the variable data and text added by the user. 

Text can be edited on this screen. 
CRLF column If the check box next to an item has a checkmark in it, a line break code 

is added at the end of the line. If it does not have a checkmark, no line 
break code is added, so the line is connected with the next line. 

Delete column Clicking the Delete button in a row deletes that row. 
 
 

(5) Data Preview 
Added variable data or character strings are displayed on this screen. 
This is a preview screen for barcode data. 

Displays a preview of data in the Editing Screen. In this preview, the part corresponding to variable 
data is replaced by a sample form of data for the purpose of showing an example of the counting scale’s 
output. This example has the same number of characters as actual data, although its content is not the 
same. 
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(6) Design Preview 
Adjusts the printing position of objects. 

Name Description 
Text object Displays the printing position of text data. 

The position can be changed by drag-and-drop actions. 
The contents in the Text Data menu are applied to the characters and 
size of text. A red point on the upper left of the object is the reference for 
the printing position. 

Barcode object The position can be changed by drag-and-drop actions. 
Sample data is set for the contents of the barcode. 
In the Design Preview, the contents of barcode data are not applied. 
The barcode size is adjustable on the Size menu. A red point on the upper 
left of the object is the reference for the printing position. 

 
 

(7) Create UFC Commands 
Converts the contents edited for label printing to the UFC setting commands. 
Converted data is displayed on the Send Data box. 
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3.5. How to operate the UFC-barcode mode 

Perform steps 1 to 4 in “1.3. Operation (common to both modes)”. 
Select the UFC-Barcode tab to open the UFC-barcode label settings screen. 
 
5. Creating UFC Output Format 

Edit Barcode Type, Print Settings, Text Data, Barcode Data, and Design Preview, and then press the 
Create UFC Commands button. 

 
6. Sending UFC Setting Commands from the PC to the counting scale 
 

(1) Click the Connect button, which will then change to the Send button when communication starts. 
(2) When you click the Send button, the commands displayed in the Send Data box will be sent to the 

counting scale. 
(3) Transmitted UFC Setting Commands are stored in the counting scale. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   

7. Receiving data from the counting scale 
 

□ To output data, press the print key on the counting scale. 
□ The data output is displayed in the Received Data box, so check that the contents of the data are 

correct. Confirm that the data displayed in the Received Data box starts with “^XA” and ends with 
“^XZ”. If it does not end with “^XZ”, the data count is too large. Reduce data to add in Barcode Data. 

 
8.  Ending communication 

 
 Click the Disconnect button.  

Step 5. Creating UFC Output Format 

Displays a reply to the commands sent 

Step 6. Sends UFC Setting Commands by clicking the Connect button which will change to the Send button 

Displays commands to send 



23 
 

3.6. Example of creating the UFC output format 

 
Print result Contents 

 
 
 
 
 
 
 
 
 
 
 
 
 

The QR code above is for illustrative purposes only. 

 
1. Select QR Code in the Barcode Type. 

 
2. Select Command from the Type menu in Text Data. Then, select Item Code from the Text box. 

 
3. Select Count data from the Command List menu in Barcode Data. Then, click the Add Command button. 

Enter “UW  ” in Text, and press the Add Text button. 
Remove a checkmark in the “UW  ” text column in the Editing Screen. 
Select Unit weight from the Command List. Then, press the Add Command button. 
 

4. Adjust the positions of text and barcode in the Design Preview. 
 

5. Press the Create UFC Commands button to create UFC Setting Commands in the Send Data box. 
  

* Text 

“Item code” 

* QR code 

* “Number of pieces” 

* UW “Unit weight” 

Z D 5.6V 
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4. Function Mode 
 
 

4.1. How to use the function mode 

□ There are differences in settable items depending on destinations. Make sure that English is selected for the 
language in the Option menu. 

 
 

4.2. Features of the function mode 

□ You can select items and values for the function settings by using the pull-down menu. 
 
□ The current function setting can also be called up, which can be referred to or confirmed when the setting is 

changed. 
 
□ By using the check boxes, you can select items to send from the list. 
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4.3. Sections of the function mode 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(1) Tools for editing 

The function mode can be selected and the function list can be edited with these tools. 

Name Description 
Category menu Selects the large classification of the function setting. Options to be  

displayed vary depending on the model. 
F-00 / F-01 / F-02 / F-03 / F-04 / … 

Item menu Selects the small classification of the function setting. 
Options to be displayed vary depending on the Category menu. 

Setting menu Selects the setting to change. 
Items can be selected /not be selected if they have check boxes. 

Add Function button Adds the contents selected in the Setting menu to the Function List. 
Clear List button Deletes items in the Function List. 
Read Function button Reads all function setting values in the counting scale connected and 

displays in the Function List. 
 
 

(2) Function List 
Added items can be previewed and commands to send can be selected in this screen. 

Name Description 
Editing column Displays added items. 
Preview column Displays commands. 
Send column Adds checkmarks to commands to send. 

Click the column name button to add checkmarks to all items in the Item list. 
Removes all checkmarks if the button is clicked with checkmarks in all of 
the boxes. 

  

(1) Tools for editing (2) Function List 
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4.4. How to operate the Function Mode 

Perform steps 1 to 4 in “1.3. Operation (common to both modes)”. 
Select the Function Mode tab to open the function settings screen. 
 
5.  Selecting the function setting to be changed 
 

(1) Select items to be changed from the Category menu and then the Item menu. 
To check the current function settings, click the Read Function button. 
Clicking on the function setting displayed in the Function List, the Category menu and the Item menu 
are automatically selected. 

(2) Select the setting to be changed from the Setting menu, and click the Add Function button. 
The item is added to the Function List. 

(3) Add a checkmark to the Send box on the right in the Function List only for the item to be changed. 
Commands are generated in the Send Data box only for the item checked. 

 
6. Sending the function setting commands from the PC to the counting scale. 
 

(1) Click the Connect button, which will then change to the Send button when communication starts. 
(2) When you click the Send button, the commands displayed in the Send Data box will be sent line by 

line to the counting scale. Between the lines, the time set in Wait[s] will be inserted. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 5. (1) Selects and adds the item to be changed. 

 

Step 5. (3) Add checkmarks to the Send 
box of the command to be sent. 

Click the column name button to add 
checkmarks to all items in the Item list. 

 

Step 5. (2) Select the setting to be changed and  
click the Add Function button to add  
the item to the Function List. 

Step 5. (1) Reads the current function setting. 

Displays responses to the commands sent. Displays commands to be sent. 

Step 6. Sends commands by clicking the Connect button, which will change to the Send button. 



27 
 

7. Receiving data from the counting scale 
 

□ Confirm that the same number of responses (<AK>) as that of commands sent are returned. 
 If it is not, there may be items that could not be saved. In that case, adjust the time in the Wait[s] 

 menu and send commands again. 
□ If an error (EC,E*) is received, correct and resend the data. 
 For the meaning of the error, refer to the instruction manual of the counting scale. 
  
 Note 
  The factory setting of the GC series is for no command response. 
 Change function setting F-06-07 to “1” (reply to command). 

 
8. Ending communication 
 Click the Disconnect button. 
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5. Command Mode 
  

5.1. Features of the command mode 

□ You can select usable commands by using the pull-down menu.  
 
□ As item names of commands for which values (unit weight, tare weight, etc.) need to be entered are shown 

before the text, you can create commands instinctively. 
 
□ When the digits of a value entered do not match, it cannot be written in the text box. 
 Other out-of-range errors can be written in the text box, so check responses after sending commands. 
 
□ It is recommended that key commands be sent one by one, not collectively. 
 
□ By using the check boxes, you can select items to send from the Command List. 
 
□ Refer to the instruction manual of the counting scale for the characters of Item code that can be used. 
 ", (comma)" is not allowed in the item code. 
 
 

5.2. Sections of the command mode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Tools for editing 
The command mode can be selected and the command list can be edited with these tools. 

Name Description 
Command Type menu Selects the large classification of the function setting. 

Options displayed vary depending on the model. 
Command menu Selects commands. 

Options displayed vary depending on the Command Type. A text box is 
displayed for commands for which values need to be entered. 
Enter values to set based on the description (ID, UW, Tare, etc). 

Add Command button Adds the content selected in the Command menu to the Command List. 
Clear List button Clears the items in the Command List. 

(1) Tools for editing (2) Command List 
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(2) Command List 
Added items can be previewed and commands to send can be selected in this screen. 

Name Description 
Editing column Displays added items. 
Preview column Displays commands. 
Send column Adds checkmarks to commands to send. 
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5.3. How to operate the Command Mode 

Perform steps 1 to 4 in “1.3. Operation (common to both modes)”. 
Select the Command Mode tab, and open the command mode screen. 
 
5. Selecting commands 

 
(1) Select command from the Command Type menu and then the Command menu. 

Enter setting values or any other items that need to be input. 
(2) Click the Add Command button to add the item to the Command List. 
(3) Add a checkmark to the Send box on the right in the Command List for only the command to be sent. 

Commands are generated in the Send Data box for only the item with a checkmark. 
 

6. Sending commands from the PC to the counting scale 
 
(1) Click the Connect button, which will then change to the Send button when communication starts. 
(2) When you click the Send button, the commands displayed in the Send Data box will be sent line by 

line to the counting scale. 
Some commands do not function when they are sent simultaneously. If it happens, send commands 
one by one by adding a checkmark one at a time in each the Send box again, or adjust the time in 
the Wait[s] menu and send commands again. 

 

7. Receiving data from the counting scale 
 
□ Command responses are output to the Received Data box. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Ending communication 

 
 Click the Disconnect button.  

Step 5 (1) Selects command 

Step 6 Sends commands by clicking the Connect button, which will change to the Send button 

Displays commands to be sent Displays responses to the commands 
 

Step 5 (3) Displays commands after the  
Add Command button is checked. 
Add a checkmark to the Send box  
of the command to be sent. 

Step 5 (2) Adds the command selected  
to the Command List 
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6. Memory Mode 
 
 

6.1. How to use the memory mode 

□ The only factory setting items stored in the internal memory of the counting scale are unit weight (and item code). It is 
 recommended that all items (upper and lower limit values, tare, total, etc.) be set to be “items that are called up by the 
 internal memory." For details about the function settings, refer to the instruction manual of each model. 
 Ex.) With the GC series, set function setting F-08-01 to “111”. 

□ If the decimal separator that is displayed or output with the counting scale is set to ", (comma)", it may not be 
 read to the Item List. In that case, set it to ". (dot)". 
  Ex.) With the GC series, set function setting F-04-07 to “0”. 
 
 

6.2. Features of the memory mode 

□ The memory contents in the current counting scale can be listed, which makes it easy to manage. 
 
□ You can directly edit a list with text that has been read. Changed items are colored, which makes it easy to 

visually recognize where has been edited. 
 
□ By using check boxes, you can select items to be sent from the Item List. 
 
□ By saving the list read as a csv file, you can save to memory with a PC and create a file on external memory 

with the SD card (external memory is available only with the models that can use SD cards). 
 
□ Refer to the instruction manual of the counting scale for the characters of Item code that can be used. 
 ", (comma)" is not allowed in the item code. 
 
□ By using a csv file saved on a PC, you can batch write to internal memory of the counting scale. 

□ Note that items that can be stored in internal memory vary depending on the model. 
□ For items and their sequence, check the Item List column in the Memory tab. 
□ Csv files saved with the Save List button are generated in the same item array regardless of 

 models so that lists can be used as is when the model is changed. 
  Items that cannot be stored in internal memory (items that are not displayed in the Item List) are 
 filled with 0. Item code is output in blank. 

□ When editing or creating a list on an Excel file, fill undefined items other than item code with 0 before 
 converting it to a csv file. 
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  <Example of a csv file saved> 
  A: ID, B: Item code, C: Unit weight, D: Tare, E: Upper limit value, 
  F: Lower limit value, G: Total count, H: Number of additions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



33 
 

6.3. Sections of the memory mode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(1) Operation buttons 

The Item List can be edited with these tools. 

Name Description 
Counting Scale button Reads all memory data in the counting scale connected, and displays 

them in the Item List. 
CSV File button Reads a csv file saved on a PC, and displays it in the Item List. 
Add Item button Adds a new item. 

If the Add Command button is clicked without the ID having been edited, 
the line is deleted. 

Save List button Saves items displayed in the Item List in a csv file. 
If they are copied to the SD card, the card can be used as external memory. 

Add Command button Generates commands for the items whose check boxes have checkmarks 
in the Update column. The commands generated are displayed in the Send 
Data box. 

AD-8561 check box Changes the format of commands to be generated. 
When communicating with the GC series counting scale via the USB interface  
for the AD-8561-MI02, add a checkmark to the box. It is not displayed with  
models other than the GC series counting scale. 

 
  

 

(2)  Item List 

(1) Operation buttons 
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(2) Item List 
The contents of memory that has been read and added are displayed in this screen. 

Name Description 
No. column Displays the sequence of memory displayed in the Item List. 
ID column Displays the ID numbers in memory. 

By clicking the ID column, you can sort the ID numbers in order. 
Item Code column Displays the item codes in memory. Some models do not display this column. 
UW column Displays the unit weights in memory. 
Tare column Displays the tare weights in memory. 

Some models cannot edit or change this item, although they can read it. 
HI column Displays the comparator upper limit value in memory. 
LO column Displays the comparator lower limit value in memory. 
Total column Displays the total count in memory. 

Some models do not display this column. 
Addition column Displays the number of additions in memory. 

Some models do not display this column. 
Clear column Add checkmarks to the items to be deleted from internal memory of the  

counting scale. They are not deleted unless their check boxes in the  
Update column do not have checkmarks. 
Click the column name button to add checkmarks to all items in the Item List. 
Removes all checkmarks if the button is clicked with checkmarks in all of 
the boxes. 

Update column Add checkmarks to the items to be changed or added. 
Click the column name button to add checkmarks to all items in the Item List. 
Removes all checkmarks if the button is clicked with checkmarks in all of 
the boxes. 
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6.4. How to operate the memory mode 

Perform steps 1 to 4 in “1.3. Operation (common to both modes)”. 
Select the Memory tab, and open the memory mode screen. 
 

5. Creating an item list 
 

(1) Expand the memory information in the Item List. 
To check the current internal memory, click the Counting Scale button. 
To check the csv file saved on the PC, click the CSV File button. 
To add a new item, click the Add Item button. 
To rewrite the contents displayed in the Item List, move the cursor to the item and edit the texts. 

(2) For the items to be stored on the counting scale, add checkmarks to the check boxes in the Update 
column on the right in the Item List. 

□ Click the Update column name to add checkmarks to all items in the Item List. 
This removes all checkmarks if the button is clicked with checkmarks in all of the boxes. 

(3) For the items whose check boxes in the Clear column on the right in the Item List have checkmarks, 
clear command for the item is generated. 

□ For the items to be cleared, add checkmarks to the check boxes both in the Clear and the 
Update columns. 

□ Click the Clear column name to add checkmarks to all items in the Item List. 
This removes all checkmarks if the button is clicked with checkmarks in all of the boxes. 

(4) Click the Add Command button to generate commands in the Send Data box only for items with a 
check mark in the check box. 

(5) To save the current Item List to a csv file, click the Save List button. 
□ Enter a file name and save the file with “save as”. 

 
Note 1 
In the following case, the color of cells in the Item List changes. 

Yellow An item for which text has been corrected or a new item added 

Red 

Unusable numeric value or unusable character 
(Ex. 000000 is entered in the ID column, or characters other than numbers are 
entered in the Unit Weight column) 
For items that include red cells, commands cannot be generated with the 
Add Command button. 

Purple 
ID is duplicated in the Item List. 
You can easily find which ID is duplicated by clicking the ID column to sort IDs. 

Note 2 
With the GC series counting scale, you can divide the MR command, when there is a checkmark in the 
check box of the AD-8561, into MR, MI, ML, and MA. When communicating via USB interface for the AD-
8561-MI02, make sure to add a checkmark to the check box. Although there is no difference in operation 
when directly communicating with the GC series, the number of commands increases, which may require 
longer time after starting transmission until the end. 
 
Note 3 
For communication through the RS-232 interface for the AD-8561, there is no need to put a checkmark 
in the check box of the AD-8561. However, make sure to set the baud rate of the RS-232C port for the 
AD-8561 to 9600 bps or more. If it is set to 4800 bps or less, data may not be read in the Memory List 
while being read to the counting scale.  
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6. Sending setting commands from the PC to the counting scale 

 
(1) Click the Connect button, which will then change to the Send button when communication starts. 
(2) When you click the Send button, the commands displayed in the Send Data box will be sent line by 

line to the counting scale. 
Between the lines, the time set in Wait[s] will be inserted. 

 
7. Receiving data from the counting scale 
 

□ Confirm that the same number of responses (<AK>) as that of commands sent are returned. 
□ If it is not, there may be items that could not be saved. In that case, adjust the time in the Wait[s] 

 menu and send commands again. 
□ If an error (EC,E*) is received, correct and resend the data. 
 For the meaning of the error, refer to the instruction manual of the counting scale. 
 
Note 
 The factory setting of the GC series is for no command response. 
 Change function setting F-06-07 to “1” (reply to command). 

 
8. Ending communication 
 
 Click the Disconnect button.  

Step 5. (2)(3) 
To add or change items in internal memory, add 
checkmarks to the check boxes of the Update column. 
To delete items, add checkmarks to both the Clear and 
Update columns. 

Step 5. (1)  
Reads the list Sorts IDs by clicking 

the ID column 

Click the column name button 
to add checkmarks to  
all items in the Item List. 

Step 5. (5) Saves the Item List as a csv file 

This check box must have a 
checkmark when using the USB 
interface of the AD-8561-MI02. 

Step 5. (4) 
Generates a command for the ID where the  
check box of the Update column has a checkmark 

Step 6. Sends commands by clicking the  
Connect button, which will change  
to the Send button. 

Displays commands to send 
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6.5. Usage example of the memory function 

 
<How to partly change internal memory > 
 
1. Click the Counting Scale button to display internal memory in the Item List. 
2. Move the cursor to the item to be changed and correct texts. 
3. Add a checkmark to the check box in the Update column of the item changed. 
4. Repeat Steps 2 and 3 above. 
5. Click the Add Command button to generate commands to rewrite the target item. 
6. Send the commands to the counting scale with the Send button. 
 
 
<How to save internal memory as a csv file on a PC> 
 
1. Click the Counting Scale button to display internal memory in the Item List. 
2. Click the Save List button to save the file. 
 

Note 
 By writing the file created to an SD card, you can use it as external memory. 

 
 
<How to store the contents of a csv file saved to internal memory of the counting scale> 
 
1. Click the CSV File button, and then select the file saved to display it in the Item List. 
2. Click the Update column name button, and then add a checkmark to the check boxes of all items in the Update column. 
3. Click the Add Command button to generate commands to rewrite the target item. 
4. Send the commands to the counting scale with the Send button. 
 
 
<How to browse/correct the contents of an SD card> 
 
1. Save a file (csv format) on an SD card to a PC. 
2. Click the CSV File button, and then select the file saved in Step 1 to display it in the Item List. 
3. Move the cursor to the item to be changed and correct texts 
4. Click the Save List button to save as a new file. 
5. Replace the file (csv format) on the SD with the file saved in Step 4 above. 
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